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Dates to Remember

Dec. 15, 2003 General Meeting
Jan. 7, 2004 Board Meeting
Jan. 19, 2004 General Meeting
Feb. 4, 2004 Board Meeting
Feb. 16, 2004 General Meeting

Future Meeting Topics
Jan.    —  Panther 10.3 in depth
Feb.    —  We need suggestions!
March —
  

Upcoming Meeting Topic:
Holiday Pizza Par-taayy!

This is our annual end-of-the-year holiday party, with 
pop and pizza for all!  We'll have lots of prizes and 
probably a general Question-and-Answer session, so 
there will be lots of chances to "talk Mac" between bites 
of pizza.  Feel free to bring cookies or snacks to share.

By the way, the website for the automatic 
ReaderWare book, CD, and movie database software is 
www.readerware.com. Unfortunately, last month's 
demo rather fizzled out due to incompatibilities with 
Panther 10.3.1.  Honest, the software really does work 
very well with Jaguar 10.2!  

Apple unveils 
20-inch iMac

By Jim Dalrymple jdalrymple@maccentral.com
November 18, 2003--Apple Computer Inc. on Tuesday 

unveiled its latest consumer desktop machine, the 20-inch 
flat panel iMac. The new iMac joins the 15-inch Combo 
Drive and 17-inch SuperDrive models in Apple's consumer 
line-up.
"We're actually surprised to see that our competitors have 

yet to come anywhere close to the original design of the 
iMac and now we just raised the bar even higher with the 
20-inch model," Tom Boger, Apple's director of desktop 
product marketing Tom Boger told MacCentral.
The new iMac features a 1680-by-1050 resolution, two 

FireWire 400 and three high-speed USB 2.0 ports, support 
for 54Mbps AirPort Extreme 802.11g wireless networking 
and optional built-in Bluetooth for wireless connectivity.
The iMac line sports PowerPC G4 processors running at 

1.25 GHz in the 20- and 17-inch model and 1.0 GHz in the 
15-inch model. All models include 256MB of fast 333 MHz 
DDR SDRAM and an 80GB Ultra ATA/100 hard disk drive 
running at 7200 rpm. The 20- and 17-inch models also 
include NVIDIA's GeForce FX 5200 Ultra graphics 
processor with 64MB of DDR video memory, for incredible 
graphics performance.
While the iMac screen size has been revved twice now, 

Apple said the design of the iMac did not need to be altered 
to accommodate the larger screens.
"From the very beginning we designed the iMac to accept 

larger displays. The same fluid motion customers are used 
to with the 15-inch and 17-inch models will also be the 
experience with the new model," said Boger.
Apple indicates that all models are available immediate 

from the Apple Store -- the 20-inch model will cost 
US$2,199; the 17-inch model will be $1,799 and the 15-
inch iMac will cost $1,299.
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Mac Hints & Tips!
Courtesy of Paul Taylor

What Are You Doing with Your Other Hand?
Next time you see someone working on a computer, 

watch how they use their nonmouse hand. An 
advanced operator uses two hands: one on the mouse 
and the other on the keyboard, ready to activate a 
Command key shortcut. Start keeping your other 
hand on the keyboard. (I keep my thumb hovering 
over the Command key.)

As you learn more shortcuts, you can activate them 
the moment you think of them, rather than waiting 
for your hand to get back to the keyboard.

David Creamer of I.D.E.A.S.    www.IDEAStraining.com

Mac Tips
Apple has updated its .mac website with details on 

“Mac Presents,” a new • ve-part section that o• ers 
practical tips, creative ideas, and QuickTime movies 
that will help you get the most out of your Mac.

MacVIEWS, Ft. Wayne IN

Become a Power User
If you own a Mac and want to be a power user so 

that you can do things like install your own RAM, 
add hard drives, add an Airport card, etc., Apple has 
a page for you to explore: www.info.apple.com/

usen/cip/index.html.  On this page you will find a 
pull down menu. Locate your computer in the list 
and you will be taken to a page with a list of user 
installable parts! There are PDF files you can read 
and Quicktime Movies that show you exactly how to 
do it! WOW! Th e Mac is still user friendly!

Charlotte MacWorkshop, Charlotte NC

Work Efficiently By Using Folder Aliases
If you routinely have to navigate from one folder to 

another, try including an alias of the folder in the 
main folder. Th at way, you simply double-click on 
the alias to move to the other folder. You can also 
make aliases of various folders and keep them on 
your desktop to make drag-and-drop copying easier. 
To make an alias of a folder, simply select it and 
choose File >Make Alias. Your Mac then displays a 
duplicate [image] of the folder, along with a marker 
that indicates it’s an alias of a real folder.

LIMac Forum, Long Island NY

Easy Aliases   
An easier way to make an Alias is to hold down 

on the Option and Command keys while you 
click on the icon you want to make an alias of, 
and then you just drag an Alias o• of it. Th is 
works in OS 9 and OS X.

MacPac, Ponca City OK

Black on White Screen?
As you know, the correct key combo for an 

immediate shutdown is Command/ Option/ 
Control/Eject (or Command/ Option/ Control/ 
Powerkey for people with a power key equipped 
keyboard). But if you press Command/ Option/ 
Control/ asterisk (*), which is right underneath 
the eject key, it will activate the “Switch to Black 
on White” feature, which is located in the 
Universal Access Preference Pane. Th e Black on 
White (monochrome) setting makes seeing the 
screen easier for people with some types of vision 
problems.

MacVIEWS, Ft. Wayne IN

Column Upon Column
If you haven’t used column view, you should 

start. Open a new Finder window and choose

“As Columns” view from the View menu or 
choose the far right option from the View buttons 
on the toolbar. If you’re running a later version of 
OS X, you’ll see small buttons at the bottom of 
every column. Clicking and dragging right or left 
on these buttons resizes every column relative to 
the other. Holding down the Option key

resizes only that particular column.
Th e Finder, Mid-Columbia MUG

Kennewick WA

A Message from Tech Support
If you ever need to call for service support, there 

are things you can do to make things easier for 
both you and us:

First, please call from a land line if possible. 
When a customer calls on a cellular phone, the 
connection often has heavy static and/or the 
phone call drops and disconnects. This morning, 
a customer called me on a cell phone, which 
dropped the call three times. (Even worse, the 
customer was probably billed for three separate 
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Visit www.Mac-Hints-Tips.com 
...for a beautifully formatted,  

downloadable PDF file of this 
month's Mac Tips & Hints!  

Issues are typically 12 pages. Downloads 
are free, and archived back issues are also 
available.  Thanks, Paul Taylor!

Also, if you have your own Mac Tips, you 
can submit them there for inclusion in a 
future issue.  Be sure to mention DAUG! 

phone calls.) Second, if possible, please have your 
invoice ID number available. This will allow us to 
see what machine you purchased and help with 
troubleshooting. [Ed note: Yeah, right. It also 
alerts us if the machine fell off the back of a truck. 
And what if you bought it used?]
Third, please be in front of your machine and 

have it booted up. I know this sounds simple, but I 
have encountered customers who call for tech 
support for their home computers from work or 
even out on the road. It’s hard to have a customer 
run diagnostics on a machine that’s not even there. 
Fourth, if possible please have Apple System 
Profiler open. It has a good amount of information 
that will help in troubleshooting— processor type, 
amount of RAM, network settings, number and 
size of hard drives, etc. In OS X, just click on 
“About Th is Mac” under the Apple menu and 
then click the “more info” button. In OS 9, Apple 
System Profiler should be under the Apple menu. 
—Russ White 
Small Dog Electronics (smalldog.com)

OS X
OS X Driver for Old Scanners
VueScan ($40) is a popular alternative driver for 

many scanners. It often provides better results than 
the scanner’s original driver, and works with 
scanners that are no longer supported by their 
original manufacturers for use on newer Macs or 
in Mac OS X. Get it at www.hamrick.com.
Design Tools Monthly

Don’t Use Forward Slashes
Forward slashes should never be used in the name 

of a drive or partition, or virtually in any other 
name field in Mac OS X.

The reason behind this limitation stems from Mac 
OS X’s UNIX underpinnings. In prior versions of 
Mac OS, the location of a file was noted using a 
path, with the colon (:) separating objects. Mac OS 
X uses the forward slash (/) in place of the colon.

As reinforcement for why you should never use 
forward slashes, trying to access folders or files 
with slashes via AppleScript will result in failure.  
MacFixIt (www.mac• xit.com)

via LIMac Forum, Long Island NY

Any User Can Install Software
Although you need the username and password of 

an administrator to launch an application as root, 
you can do so from any account: normal or admin. 
For example, if a normal user wants to run a 
software installer that requires authentication, you 
can actually type your username and password to 
authenticate it, even though you aren’t logged into 
your account.

Mac OS X Power Tools

Play With Your Icons
Check out “Show View Options” under the View 

menu (Command/J). You can play with icon sizes, 
text sizes, and other interesting options here. 
“Show item info” is one of the more interesting 
ones here.

Mouse Droppings, Corvallis OR

Speed Up OS X
With an older Mac, choosing “Thousands” of 

colors instead of “Millions” can decrease the load 
on your video card and squeeze a little more 
performance out of OS X.  Mac OS X Power Tools

Faxing in Panther
When you send a fax, an icon for your connection 

(such as Internal Modem) appears in the Dock. If 
the job doesn’t go through and you accidentally 
close the window belonging to the connection, the 
interface disappears. To get it back, don’t bother 
searching for a fax application as I did; instead, 
launch Printer Setup Utility from the Utilities 
folder of your Applications folder, and choose 
“Show Fax List” from the View menu.   TidBits   
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FireWire Web Cams
Apple's iSight Goes Up Against 

Established Products 
By Matthew Honan

Apple's iChat AV software (in beta at press 
time) has made videoconferencing as easy as 
plugging in a cable and turning on your smile. 
To make chatting even easier, Apple released 
its own camera, the iSight, to work with iChat 
AV. But the iSight is the new kid on the block; 
FireWire Web cams have been around for a 
couple of years. So we wondered how the 
iSight would stack up against established 
products, notably Orange Micro's iBot 
Standard, ADS Technologies' Pyro 1394 
WebCam, and Unibrain's Fire-i. 

We tested the cameras with an 800MHz 
iBook, a 1GHz Titanium PowerBook G4, and a 
dual-processor 533MHz Power Mac G4, and 
we used DSL, cable modem, T1, and AirPort 
(802.11b) connections. We also evaluated the 
cameras to see how they performed under a 
variety of conditions. All of these cameras have 
video rates as high as 30 frames per second, 
capture video to applications such as 
QuickTime Broadcaster, and work out-of-the-
box with iChat AV. The iSight outperformed the 
others in nearly every situation, but all of the 
cameras performed well.

Ready for Your Close-Up?
None of the cameras' output comes close to 

DV-camcorder quality. But thanks to FireWire's 
much faster data-transfer rate, all of them 
produce smooth video far superior to the jerky 
USB and serial video of Web cams from a few 
years ago. The iSight's overall picture quality 
was noticeably better than that of the other 
cameras. It almost always provided a sharp, 
crisply defined image and did the best job with 
movement and backlighting. The Pyro slightly 
edged out the iBot in image quality, but the two 
were closely matched. The Fire-i had the 
lowest overall picture quality, but it made up for 
this in other areas. 

The iSight also had the best color of the 
bunch, followed closely by the Pyro and then 
the iBot. All three of these cameras performed 
tremendously well in our informal color tests. 
However, one of our testers, a film and video 
editor who uses iChat AV to connect to remote 
sets, noted that the iSight gave him the best 
sense of what a final shot would look like. 

(continued on page 6)

US House overwhelmingly 
passes antispam bill

By Laura Rohde, IDG News Service

November 24, 2003 -- The U.S. Congress moved a 
step closer to passing its first law regulating unsolicited 
commercial e-mail -- or spam -- on Saturday when the 
U.S. House of Representatives approved a bill that seeks 
to impose fines on those sending spam.

The Controlling the Assault of Non-Solicited 
Pornography and Marketing (CAN-SPAM) Act was 
approved by a vote of 392-5. The move follows the U.S. 
Senate's approval of its version of the Can-Spam Act in 
October with a 97-0 vote.

The two bills need to be merged into joint legislation 
before it is presented to the U.S. president for his 
approval. It is expected that the Senate will accept the 
House's wording of the bill and that President George 
Bush will sign the bill into law before the end of the year.

The vote came after the House Energy and Commerce 
Committee was able to broker an agreement on Friday to 
attach a provision in the bill for a "Do-Not-SPAM" 
registry based on the country's "Do-Not-Call" registry for 
unwanted and unsolicited telemarketing telephone calls, 
according to the committee's chairman, Representative 
Billy Tauzin, a Louisiana Republican.

Bill Gates, chairman and chief software architect of 
Microsoft Corp., praised the House for its approval of the 
bill, calling the legislation a critical component in the 
broader fight against spam. "Microsoft particularly 
supports the strong enforcement provisions, and the ban 
on falsifying the origin of e-mail solicitations and illegally 
obtaining lists of e-mail addresses, both of which will help 
Internet service providers prosecute spammers," Gates 
wrote in an article for The Washington Post newspaper, 
which was also released as a statement by the Redmond, 
Wash., software company.

In contrast, the Coalition Against Unsolicited 
Commercial Email (CAUCE), condemned the bill as 
being weak against marketers and for overriding tougher 
"opt-in" legislation passed by various states, including 
California. The "opt-out" method touted by the Can-Spam 
Act puts the onus on individual users to let companies 
know that they do not wish to receive spam.

The California law, which is due to take effect Jan. 1, 
seeks to prevent e-mail users from getting e-mail 
advertisements unless they asked to be on the sender's list 
and would impose stiff fines on senders of unsolicited 
messages.

The CAUCE also criticized the Can-Spam Act for 
limiting enforcement "to overworked regulatory and law 
enforcement agencies, rather than giving consumers legal 
tools with which to protect their own inboxes."  
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From Upgrading a Hard Drive to Building a 
Mac Clone, These Projects Will Help You Make 

the Most of Your Hardware 
www.macworld.com/2003/08/features/doityourselfmac/

Ever wish you could burn a DVD with your first-
generation Power Mac G4? Pondered building your own 
Mac? How about upgrading the hard drive in your flat-
panel iMac? Or networking your USB printer? Even 
extending the reach of your AirPort network?

You may never have considered these types of add-
ons and extensions -- or if you have, you didn't know 
how to accomplish them. But you can do these things, 
and you don't need to be a tech whiz. 

We've put together the ultimate hardware guide, 
chock-full of do-it-yourself upgrades, as well as tips on 
making better use of your media and digital cameras 
and camcorders. We hope you'll be convinced that 
taking control of your hardware is well within your reach.

Install a SuperDrive

What You'll Need:     #2 Phillips screwdriver   
Grounding strap  &  Pliers  (optional)

Thanks to DVD-burning optical drives and Apple's 
iDVD, today's Macs can put everything from your best 
friend's wedding to large corporate training videos on 
DVD. iDVD's strongest point is that it simplifies the 
rather complicated process of DVD authoring, and it's 
surprisingly powerful. The biggest complaint about the 
application, however, is that it doesn't work with external 
FireWire DVD-RW drives. This seems to leave only a 
few options for Mac users who don't have built-in 
SuperDrives -- purchasing Apple's $499 DVD Studio 
Pro, buying a FireWire burner that comes with its own 
DVD-authoring software (such as those from Formac 
and LaCie), or buying a new Mac.

Fortunately, there is another option. Apple says you 
need a Mac with a SuperDrive to run iDVD, but what 
iDVD really requires is a DVD burner on an internal ATA 
bus. Install a DVD-RW drive in an older Power Mac G4, 
and iDVD will find what it's looking for. You can pick up 
a 4x Pioneer DVD burner (the DVR-A05, the same 
model Apple uses) for less than $250 online, so now's a 
great time to turn your first-generation G4 into a DVD-
burning computer.

Step 1: Cut through the Static

Before adding components to or removing them from 
your Mac, you need to discharge static electricity that 
may have built up. To do so, shut down your Mac -- but 
don't unplug it yet. Leaving the Mac plugged into a 
grounded outlet ensures that any static you discharge 
has somewhere safe to go. Now touch some metal on 
the computer (the access covers for PCI slots are good, 

The Do-It-Yourself Mac     By Macworld Staff  

or open the case and touch the optical-drive–bay 
chassis). Unplug your Mac. Try to avoid carpeted 
surfaces while you work on your Mac's guts, or buy 
a grounding strap, for $5-10, from an electronics 
store.

Step 2: Dive In

To remove the drive bezel from your Mac, open 
the access door and find the two tabs at the front of 
the computer, next to the optical-drive enclosure A. 
Press them both in and push out toward the front of 
the case until one side of the front bezel pops out. 
Grab the bezel from the front; pull it completely off.

Step 3: Remove Screws

Locate the two screws directly underneath your 
current optical drive B. Remove them with your #2 
Phillips screwdriver and set them in a safe place.

Step 4: Unplug It All

Unplug the ATA ribbon C and power connectors 
D from your optical drive E. If you have a Zip drive, 
remove its cables as well. You may need pliers to 
help you pull them out. Be sure not to pull the 
ribbons or wires themselves, and be gentle with the 
pliers. You may find it easier to get your fingers in 
there if you slide the drive housing forward a bit.

Step 5: Out with the Old, In with the New

Remove the drive housing by sliding it all the 
way out through the front of the Mac. Turn the 
housing over and locate the four screws that attach 
the optical drive to the housing F. Remove the 
screws, pull out the old optical drive, and then slide 
the new drive G in. When the housing's holes and 
the drive's holes line up, the drive is in the proper 
place. Now securely replace the 4 screws.

Step 6: Attach the Connectors

Slide the drive housing about halfway through 
the front of your G4, making sure the ribbon 
underneath stays flat H. Reach into your Mac and 
attach the power and ATA connectors to the back of 
your new drive (and to the Zip drive, if you have 
one). Once those are secure, slide the drive all the 
way in.

Step 7: Finish Up

Lastly, replace the two front screws you removed 
earlier, and then snap the front bezel back into 
place. Install iDVD on your G4. If you don't already 
have it, you'll need to get Apple's $49 iLife suite, 
which contains iDVD 3 -- the only iLife app you can't 
download. Your Mac is now ready to use iDVD, as 
well as burn and play DVDs. -- jonathan seff

(continues on p. 6)
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Do It Yourself Mac (con't from p. 5)

Better Burning

Now that you've got a shiny new SuperDrive in your G4, 
you can benefit from these media-burning tips.

> To get the fastest possible burning from your drive, use 
media with the same rating as your drive. Some 2x DVD 
media burn at 1x on a 4x burner; likewise, some 4x media 
burn at 1x on a 2x burner.

> To make the discs you burn compatible with as many 
drives as possible, burn media at 1x.

> Older DVD drives are more finicky than recent models. 
If you don't know the age of the DVD player you're targeting, 
use Apple or other name-brand media, which are more likely 
to be recognized and played.

> Before you buy a 50-pack spindle of unknown media, 
buy and burn a few sample discs to make sure the quality is 
good.

> Read media packaging closely -- one symbol can make 
all the difference. For example, DVD-R drives don't burn to 
DVD+R media.

> Mac OS X doesn't support DVD-RW. If you want to 
create DVD-RWs in OS X, you'll need an application such as 
Roxio's Toast or Charismac's Discribe.   

How the iSight Stacks Up (con't from page 4)

The iSight is the only camera with an autofocus 
feature, which is both good and bad. We liked the 
autofocus for its ability to focus on specific items, follow a 
moving object, and quickly change from an extreme close-
up to a regular shot -- particularly handy if you want to 
display a document during a chat. But the iSight's 
autofocus sometimes focused on the wrong area, such as 
the background when another person entered the shot 
from behind.  Note: See the rest of this lengthy article at:

www.macworld.com/2003/12/reviews/firewirewebcams/

from 
www.MacRumors.com

Appleinsider reports that Microsoft 
"will officially renew its commitment" to 
the Mac platform at the upcoming 
MacWorld San Francisco in January.

Microsoft is said to be working on 
upgrades for the Mac version of 
Microsoft Office with a new project 
manager and a significant focus on 
Entourage. The new version is 
expected to be announced at Steve 
Jobs' Keynote speech for MacWorld 
Expo. In addition, updates to MSN 
Messenger and Remote Desktop 
Connection client are expected in the 
next year.

Appleinsider also reports that Virtual 
PC 7.0 will also be announced and 
delivered in the same timeframe as the 
new Office package. Virtual PC 7.0 
would bring long anticipated G5 
compatibility to the popular emulation 
software.

While Microsoft acquired Virtual PC 
from Connectix primarily for its 
Windows versions of VPC, Microsoft's 
Mac Business Unit has promised 
ongoing active development of the 
Mac version. Due to changes in the G5 
architecture, prior versions of Virtual 
PC have remained incompatible with 
the PowerMac G5s.

Updated: Mac4ever.com 
(French) reported on December 1st in 
an interview with a Microsoft 
representative at MacExpo in London. 
In their video interview, the rep felt that 
Virtual PC for G5 would likely be 
released in February 2004 and 
"Microsoft Office 2003" for Mac would 
be released in the Summer of 2004. 

SITE for SITES    
Below are some favorite Mac websites:

MacSurfer.com VersionTracker.com 
OSXHints.com      MacAttorney.com    
MacDownload.com  VersionTracker.com
MacCentral.com     MacMilitia.com     
MacRumors.com     MacInTouch.com

Site of the month:  

www.mac-hints-tips.com
A nicely formatted PDF newsletter of helpful Mac 
Tips 'n' Hints is available for download--free! The 
tips cover a lot of topics, and back issues are also 
available. 
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iList
The DuPage Apple User Group 

Information List is available now! The list is 
intended for the exchange of information, help 
request, meeting topic requests, 
announcements and more. You can subscribe 
today by sending and e-mail message with the 
subject "Subscribe" to iList@DAUG.org. 
Within a few minutes, you will receive a 
confirmation message. You must reply to this 
message to complete your subscription! After 
you are subscribed, you can send a message to 
iList@DAUG.org and it will be forwarded to 
all members of the list.

I.M.H.O....     Linda Cowls, Editor

"My Mac isn't working..." Oh, really?
"I just got an iMac off e-Bay, but it won't work! Can you 

help me?"  "Does is turn on?" I asked. "Yeah. But I just 
can't get it to work right."

So I packed up a back-up system install disk, my Norton 
Utilities, and a few CDs of shareware, and headed on over. 
When I got there, the iMac turned on fine.  Checked the 
system, it was already updated and OK.  Ran Norton; no 
problems.  What gives? 

"There's nothing wrong with your Mac," I said. 
"But I can't do anything on it. I can't type a letter, or draw 

a picture, or set up a simple database."  
The real issue, it turned out, is that she expected a copy 

of ClarisWorks or AppleWorks to be on that Mac,which 
wasn't there.  I installed my copy for her (since it IS 
supposed to come on all iMacs) and she was pleased. But I 
couldn't help but ponder the implication of her quandry, 
which, to me, amounted to a huge lack of communication.

How many other Mac users are out there, or worse, 
switchers from the Other Side, lamenting that their perfectly 
good Macs "don't work right" when what they really mean 
is "I don't have the right software" or "I don't know how to 
use this"?  How many people have said things like this in 
front of computer greengills who are in the market, trying to 
decide between Mac and PC, and end up getting turned off 
to Mac and going with a PC because they simply  didn't 
understand what was being said?  It's a scary, scary thought.  

DAUG Officers
Jim Rietz (630) 910-7075
President President@DAUG.org

Doug Stetina (630) 323-3448
Vice President/ VicePresident@DAUG.org
 Program Chairman dstetina@aol.com

Adele Marx (815) 568-1712
Secretary adelm@charter.net

Jackie Calamos (630) 986-8412
Treasurer LightLady@interaccess.com

Phil De Buhr (630) 985-9449
Membership membership@daug.org

Linda Cowls (630) 455-1488
Newsletter Editor LindaC26@aol.com

Carl Marx (815) 568-1712
Ambassador-at-Large carlm1@earthlink.net

Bob Kaysen NEED PHONE 
Member-at-Large & EMAIL

Help List
The following members have agreed to help other 
DAUG members with various computer problems 
they may be having. While phone calls are 
acceptable, email is the preferred method of contact. 
If you would like to help other members, send email 
to: President@DAUG.org. Be sure to include your 
Area of Help, Name, Phone, Email. Current opening 
available for a ClarisWorks/AppleWorks person!
 
Internet and online 

Don Pokorny  (630) 985-9065  Contract73@aol.com

Spreadsheets, Databases, Video

Jim Rietz (630) 910-7075  jrietz@think-different.com

DTP, online,  Apple II, PC Connectivity 

Ed Danley (630) 961-2462 EdwardD20@aol.com

Microsoft Word, QuarkXpress

Linda Cowls (630) 455-1488 LindaC26@aol.com

Classifieds
Need to find:

A SCSI 25-pin to 50-pin adapter, with pins on 
both ends.  Or, a 50-pin SCSI gender-bender.  
Please bring to next meeting or call Linda at  630. 
455. 1488 if you have one lying around.  
Have an item to buy or sell?  E-mail Linda or 
Jim!

    DAUG.org Goodies
Check out our website at 

www.DAUG.org.  There you'll find a 
DAUG calendar, archived PDF copies of 
newsletter back-issues, and info about the 
group and upcoming topics.    
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registered trademarks of Apple Computer, Inc. PowerPC and 
the PowerPC logo are trademarks of International Business 
Machines Corporation, used under license therefrom. All other 
brand names mentioned are registered trademarks or 
trademarks of their respective holders, and are hereby 
acknowledged.

The Fine Print
The opinions, statements, positions and views stated in the 

DAUG Bytes are those of the author(s) and not those of the 
DuPage Apple User Group or any other organization unless 
clearly stated otherwise. Trademarks, logos, service marks and 
names of products which are registered to Apple Computer, 
Inc. appearing in this publication are used with the permission 
of Apple Computer Inc.

Please note: your renewal date is 
on your label. The renewal cost 
is $25 per year. You may renew 
by mail or at any meeting.

This month’s newsletter was 
created in AppleWorks 6, using 
drawing and word processing. 

First Class Mail

8 December  2003 DAUG Bytes
The Purpose of the 

DuPage Apple User Group
The DuPage Apple User Group is a 

community based Apple User Group. The main 
purpose of the DuPage Apple User Group is to 
promote and encourage the education, training 
and understanding of its members and guests in 
the use of APPLE microcomputers in homes, 
schools and businesses. The DuPage Apple User 
Group is not affiliated in any way with Apple 
Computer, Inc. 
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